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RX Family 

QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

Summary 

QE for Display [RX,RA] is a plug-in for the e2 studio integrated development environment with support for 
suitable Renesas RX microcontrollers and provides a graphical interface for display control to assist in the 
development of embedded systems incorporating display devices. 

QE for Display [RX] 2.0.0 and later versions are capable of supporting emWin GUIs, which are based on a 
high-performance graphics library from SEGGER Microcontroller. QE for Display [RX] 2.1.0 and later 

versions are also capable of supporting GUIs created with Aeropoint GUI for RX, which is GUI middleware 
from CRI Middleware. This enables selecting the GUI drawing tool that best suits your needs. 
In addition, QE for Display [RX,RA] 3.1.0 and later versions support serially connected LCDs, making it 
possible to display LCDs even on RX MCUs not equipped with a graphic LCD controller (GLCDC). 

The emWin library is a high-reliability embedded GUI solution which has been adopted in various fields. It 
supports all kinds of displays, achieves high performance while minimizing the footprint in memory, and 
allows embedding of the GUIs in a great variety of systems. In addition, the emWin bundle incorporates 
AppWizard, which makes it easy to configure an excellent GUI through intuitive operations. 

For Aeropoint GUI, the GUI design can be implemented by simply using PowerPoint to configure the 
screen and set up the layout of GUI components to be seamlessly confirmed on the actual machine. 
Furthermore, the system employs an excellent subtractive color technology, which allows the drawing of fine 
images from 256-color (8-bit) image data, thus enabling the creation of GUIs to be run on larger displays 
even from microcontrollers with relatively little memory. Aeropoint GUI can be used by MCUs incorporating a 
GLCDC. 

QE for Display [RX,RA] covers everything from the initial adjustment of the display to the creation of designs 
for screens. It can also be interlinked with various GUI development solutions to provide total support for the 
development of GUIs within short timeframes. 

This application note describes procedures for displaying GUIs on a serially connected LCD using various 
tools interlinked with QE for Display. When using an MCU that incorporates GLCDC, refer to the RX Family 
QE for Display [RX] Application Note (R20AN0582). 

 

Target Devices 

All RX Family devices 
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Assumed Operating Environments 

For the procedures described in this application note, operation in one of the following environments is 
assumed. 

• Renesas Starter Kit for RX130-512KB 

• Target Board for RX130 

• Renesas Starter Kit for RX140 

• Renesas Starter Kit for RX231 

• Target Board for RX231 

• Renesas Solution Starter Kit for RX23W 

• Target Board for RX23W 

• Target Board for RX23W module 

• Renesas Starter Kit+ for RX64M 

• Target Board for RX65N 

• Renesas Starter Kit for RX660 

• Target Board for RX660 

• Renesas Starter Kit+ for RX671 

• Target Board for RX671 

• Renesas Starter Kit+ for RX71M 

 

When you apply this application note with a different device or board, adjust the settings to be appropriate 
and thoroughly evaluate the results. 
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1. Overview 

QE for Display [RX,RA] is a tool that provides a graphical interface for display control.  

The AppWizard GUI drawing tool allows you to design a GUI in a short time by combining prepared 
resources and settings without having to spend a long time for reading manuals or coding programs. These 
tools also allow the efficient implementation of detailed specifications in response to various demands using 
the API functions provided by the emWin library. 

In addition, as shown in Figure 1.1, LCD Development Environment Structure, QE for Display [RX,RA] can 
also be used with the Smart Configurator, which simplifies embedding of the Renesas drivers, and Firmware 
Integration Technology (FIT), which provides drivers and middleware for the RX family. These tools can 
further simplify display control and the creation and display of GUIs. 

This application note mainly concerns the use of the following FIT modules and the Smart Configurator that 
are provided with QE for Display [RX,RA], which serves as the nucleus. 

• emWin Firmware Integration Technology (emWin FIT) module 
 
The flowchart on the following page describes the basic procedure for developing systems with the use of 
QE for Display [RX,RA]. 

 

e
2
 studio

User Project
Smart Configurator

QE for Display  +  emWin

FIT(RX)
GUI middleware

SCI driver

GUI middleware

SCI driver

GUI source code Evaluation Board

 

Figure 1.1   LCD Development Environment Structure 
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1.1 System Development Flow Using QE for Display [RX,RA] 

Figure 1.2, System Development Using QE for Display [RX,RA] shows the system development flow using 
QE for Display [RX,RA]. 
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Configurator settings

Create a program

Execute the program

Create a project by using the Smart Configurator.

Set clocks, components, and pins for the user board.

Check the display when the

 program runs
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connect a debugger.

Connect the emulator to the user board and execute the program.

OK

NG
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Start

Check the specifications Check the specifications required for the LCD panel on the user board.

Create a GUI Start the AppWizard GUI drawing tool to design the GUI. 

After having done so, generate the corresponding code from the AppWizard.

Make the emWin settings Make the settings for emWin in QE for Display [RX,RA]. 

After having made the settings, output the header file.

Output the header file

following setting.

Generate code.

  

Figure 1.2   System Development Using QE for Display [RX,RA] 
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2. Operating Environment 

The procedures described in this application note assume operations on one of the boards listed under 
“Assumed Operational Environments”. 

 

Table 2.1   Development Environment 

Item Contents 

Integrated development 

environment 

Renesas Electronics 

e2 studio 2022-07 

C compiler Renesas Electronics 

C/C++ Compiler Package for RX Family V.3.04.00 

Compiler option 

-lang = C99 

 

 
Conditions used in confirming operations on each of the boards are listed in the following table. 

Required changes to the board, such as cutting or shorting patterns, are listed in “Board Settings.” When no 
changes are indicated, the board can be used in factory default conditions. 

 

Table 2.2   Conditions for Confirming Operation (RSK RX130) 

Item Contents 

MCU used R5F51308ADFP (RX130 Group) 

Operating frequency • Main clock: 8 MHz 

• PLL: 32 MHz (main clock x 1/2 x 8) 

• System clock (ICLK): 32 MHz (PLL x 1/1) 

• Peripheral module clock B (PCLKB): 32 MHz (PLL x 1/1) 

Endian Little endian 

Emulator E2 Lite 

Connection type FINE 

Board used Renesas Starter Kit for RX130-512KB 

 (Product No.: RTK5051308Sxxxxxxx) 

 
Table 2.3   Conditions for Confirming Operation (Target Board RX130) 

Item Contents 

MCU used R5F51308ADFP (RX130 Group) 

Operating frequency • HOCO clock: 32 MHz 

• System clock (ICLK): 32MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 32 MHz (HOCO x 1/1) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Target Board for RX130 

(Product No.: RTK5RX1300C00000BR) 
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Table 2.4   Conditions for Confirming Operation (RSK RX140) 

Item Contents 

MCU used R5F51406BDFN (RX140 Group) 

Operating frequency • Main clock: 8 MHz 

• PLL: 48 MHz (main clock x 1/1 x 6) 

• System clock (ICLK): 48 MHz (PLL x 1/1) 

• Peripheral module clock B (PCLKB): 24 MHz (PLL x 1/2) 

Endian Little endian 

Emulator E2 Lite 

Connection type FINE 

Board used Renesas Starter Kit for RX140 

 (Product No.: RTK551406BS00000BE) 

 

Table 2.5   Conditions for Confirming Operation (RSK RX231) 

Item Contents 

MCU used R5F52318ADFP (RX231 Group) 

Operating frequency • Main clock: 8 MHz 

• PLL: 54MHz (main clock x 1/2 x 13.5) 

• System clock (ICLK): 54 MHz (PLL x 1/1) 

• Peripheral module clock B (PCLKB): 27 MHz (PLL x 1/2) 

Endian Little endian 

Emulator E2 Lite 

Connection type FINE 

Board used Renesas Starter Kit for RX231  

 (Product No.: R0K505231S900BE) 

 

Table 2.6   Conditions for Confirming Operation (Target Board RX231) 

Item Contents 

MCU used R5F52318ADFP (RX231 Group) 

Operating frequency • HOCO clock: 32 MHz 

• System clock (ICLK): 32MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 16 MHz (HOCO x 1/2) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Target Board for RX231 

 (Product No.: RTK5RX2310C00000BR) 
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Table 2.7   Conditions for Confirming Operation (RSSK RX23W) 

Item Contents 

MCU used R5F523W8ADBL (RX23W Group) 

Operating frequency • HOCO clock: 54 MHz 

• System clock (ICLK): 54 MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 27 MHz (HOCO x 1/2) 

Endian Little endian 

Emulator E2 Lite 

Connection type FINE 

Board used Renesas Solution Starter Kit for RX23W  

 (Product No.: RTK5523W8xxxxxxxxx) 

 

Table 2.8   Conditions for Confirming Operation (Target Board RX23W) 

Item Contents 

MCU used R5F523W8ADNG (RX23W Group) 

Operating frequency • HOCO clock: 32 MHz 

• System clock (ICLK): 32MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 16 MHz (HOCO x 1/2) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Target Board for RX23W 

 (Product No.: RTK5RX23W0C00000BJ) 

 

Table 2.9   Conditions for Confirming Operation (Target Board RX23W module) 

Item Contents 

MCU used R5F523W8CDLN (RX23W Group) 

Operating frequency • HOCO clock: 32 MHz 

• System clock (ICLK): 32MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 16 MHz (HOCO x 1/2) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Target Board for RX23W module 

 (Product No.: RTK5RX23W0C01000B) 

Board settings 

(jumper/switch) 

<Pmod: CN2> 

Cut SS2, short SO3 
Cut SS1 and SO2, short SO1 
(Use Type 2A) 

<Others> 

Default settings 
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Table 2.10   Conditions for Confirming Operation (RSK RX64M) 

Item Contents 

MCU used R5F564MLCDFC (RX64M Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 Lite 

Connection type JTAG / FINE 

Board used Renesas Starter Kit+ for RX64M  

 (Product No.: R0K50564MSxxxxx) 

 

Table 2.11   Conditions for Confirming Operation (Target Board RX65N) 

Item Contents 

MCU used R5F565NEDDFP (RX65N Group) 

Operating frequency • HOCO clock: 16 MHz 

• System clock (ICLK): 16MHz (HOCO x 1/1) 

• Peripheral module clock B (PCLKB): 4 MHz (HOCO x 1/4) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type JTAG / FINE 

Board used Target Board for RX65N 

 (Product No.: RTK5RX65N0C00000BR) 

 

Table 2.12   Conditions for Confirming Operation (RSK RX660) 

Item Contents 

MCU used R5F56609HDFB (RX660 Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 Lite 

Connection type JTAG / FINE 

Board used Renesas Starter Kit+ for RX64M  

 (Product No.: R0K50564MSxxxxx) 

 
  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 10 of 71 

Oct.31.22  

Table 2.13   Conditions for Confirming Operation (Target Board RX660) 

Item Contents 

MCU used R5F56609BDFP (RX660 Group) 

Operating frequency • HOCO clock: 16 MHz 

• PLL: 240MHz (main clock x 1/1 x 15) 

• System clock (ICLK): 120MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Target Board for RX660  

 (Product No.: RTK5RX6600C00000BJ) 

Board settings 

(jumper/switch) 

<Operating voltage> 
Mount header J3 (select 3.3V) 
Remove resistor R52 
 
<Pmod: CN1> 
Cut SS13, short SC1 
Cut SS14, short SC2 
 (Use Type 2A) 

<Others> 

Default settings 

 
Table 2.14   Conditions for Confirming Operation (RSK RX671) 

Item Contents 

MCU used R5F5671EHDFB (RX671 Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 Lite 

Connection type JTAG / FINE 

Board used Renesas Starter Kit+ for RX671  

 (Product No.: RTK55671EHS10000BE) 
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Table 2.15   Conditions for Confirming Operation (Target Board RX671) 

Item Contents 

MCU used R5F5671EHDFP (RX671 Group) 

Operating frequency • HOCO clock: 16 MHz 

• PLL: 240MHz (main clock x 1/1 x 15) 

• System clock (ICLK): 120MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type JTAG / FINE 

Board used Target Board for RX671  

 (Product No.: RTK5RX6710C00000BJ) 

Board settings 

(jumper/switch) 

<Pmod: CN1> 

Cut SS13, short SC1 

Cut SS14, short SC2 

 (Use Type 2A) 

 

<Others> 

Default settings 

 
Table 2.16   Conditions for Confirming Operation (RSK RX71M) 

Item Contents 

MCU used R5F571MLCDFC (RX71M Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 240 MHz (PLL x 1/1) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

Endian Little endian 

Emulator E2 Lite 

Connection type JTAG / FINE 

Board used Renesas Starter Kit+ for RX71M  

 (Product No.: R0K50571MSxxxxx) 

 
  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 12 of 71 

Oct.31.22  

3. Related Documents 

Also refer to the following documents which are related to this application note. 

 

Table 3.1   Documents Related to FIT Modules 

Document Title Document No. 

Firmware Integration Technology User's Manual R01AN1833 

RX Family Board Support Package Firmware Integration Technology Module R01AN1685 

RX Family emWin v.6.26g Module Firmware Integration Technology R01AN6452 

 
Table 3.2   Document Related to Tools 

Document Title Document No. 

Renesas e2 studio Smart Configurator User Guide R20AN0451 

 
Table 3.3   Documents Related to Boards 

Document Title Document No. 

RX130 Group Renesas Starter Kit User’s Manual R20UT3921 

RX130 Group Target Board for RX130 User’s Manual R20UT4169 

RX140 Group Renesas Starter Kit for RX140 User’s Manual R20UT5026 

RX231 Group Renesas Starter Kit User’s Manual R20UT3027 

RX231 Group Target Board for RX231 User’s Manual R20UT4168 

RX23W Group Renesas Solution Starter Kit for RX23W User’s Manual R20UT4446 

RX23W Group Target Board for RX23W User’s Manual R20UT4634 

RX23W Group Target Board for RX23W module User’s Manual R20UT4890 

RX64M Group Renesas Starter Kit+ User’s Manual For CubeSuite+ R20UT2590 

RX65N Group Target Board for RX65N User’s Manual R20UT4167 

RX660 Group Renesas Starter Kit for RX660 User’s Manual R20UT5017 

RX660 Group Target Board for RX660 User’s Manual R20UT5068 

RX671 Group Renesas Starter Kit+ for RX671 User’s Manual R20UT4879 

RX671 Group Target Board for RX671 User’s Manual R20UT4894 

RX71M Group Renesas Starter Kit+ User’s Manual R20UT3217 

 
Table 3.4   Documents Related to Devices 

Document Title Document No. 

RX130 Group User’s Manual: Hardware R01UH0560  

RX140 Group User’s Manual: Hardware R01UH0905  

RX230 Group, RX231 Group User’s Manual: Hardware R01UH0496 

RX23W Group User’s Manual: Hardware R01UH0823 

RX64M Group User’s Manual: Hardware R01UH0377 

RX65N Group, RX651 Group User’s Manual: Hardware R01UH0590 

RX660 Group User’s Manual: Hardware R01UH0937 

RX671 Group User’s Manual: Hardware R01UH0899 

RX71M Group User’s Manual: Hardware R01UH0493 

 

 

Please use the latest versions that are available. Visit the Renesas Electronics Web site to check and obtain 
the latest versions.  
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4. Procedures for Execution 

This chapter describes the procedures for creating a new project in the e2 studio, using QE for Display 
[RX,RA] to set the LCD and emWin, designing the GUI, and displaying the resulting project. 

The results of emWin, which enable the efficient creation of the GUI, are generated as FIT modules for 
embedding in the project using the Smart Configurator. Since the settings for emWin can be made from the 
GUI of QE for Display [RX,RA], the user can smoothly proceed with GUI development according to the 
workflow. 

Before starting this project, be sure to make the jumper settings as stated in chapter 2, Operating 
Environment, as required. 

 

Preparation 

1. Installing QE for Display [RX,RA] 
 
Procedure 

2. Creating a new project 

3. Making the clock settings 

4. Making the emWin settings according to the workflow of QE for Display [RX,RA] 

5. Building the project 

6. Connecting a debugger and executing the program 
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4.1 Installing QE for Display [RX,RA] 

Install QE for Display [RX,RA] in the e2 studio integrated development environment. Use the following 
procedure to install this product. 

 

4.1.1 Installing QE for Display [RX,RA] 

4.1.1.1 Updating the e2 studio using its installer 

For updating the e2 studio, refer to section 3, Updating Your Product, described in “[Upgraded to version] e2 
studio 2022-07” in Renesas Tool News (document No. R20TS0685EJ0100). 

https://www.renesas.com/search/keyword-search.html#genre=document&q=r20ts0685 

 

Select “QE for Display [RX,RA]” for “Additional Software” in the installer of the e2 studio. 

Note: Since this step is not possible in situations where an Internet connection is not available, update QE 

for Display [RX,RA] with the method described in section 4.1.1.3, Installing QE for Display [RX,RA] by 

downloading the installer from the Web site. 
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4.1.1.2 Installing QE for Display [RX,RA] using Renesas Software Installer of the e2 studio 

Refer to the following for how to install QE for Display [RX,RA]. 

1. Start the e2 studio. 

2. Select the “Renesas Software Installer” menu item from “Renesas Views” to open the “Renesas Software 

Installer” dialog box. 

3. Select “Renesas QE” and click on the “Next” button. 

4. Select the “QE for Display [RX,RA] (v3.1.0)” checkbox and click on the “Finish” button. 

5. Confirm that the “Renesas QE for Display [RX,RA]” checkbox has been selected in the “Install” dialog box 

and click on the “Next” button. 

6. Confirm that “Renesas QE for Display [RX,RA]” is selected as the target of installation and click on the 

“Next” button. 

7. After confirming the license agreement, select the “I accept the terms of the license agreements” radio 

button if you agree with the license agreement, and click on the “Finish” button. 

8. If the dialog box for the trust certificate is displayed, confirm the certificate and click on the “OK” button to 

continue installation. 

9. Restart the e2 studio by following the instructions on the screen. 

10. Start this product from the “Renesas QE” menu under “Renesas Views” of the e2 studio. 
 
Note: Since this step is not possible in situations where an Internet connection is not available, download 

the installer of QE in a different environment and update QE for Display [RX,RA] with the method 

described in section 4.1.1.3, Installing QE for Display [RX,RA] by downloading the installer from the 

Web site. 

 

4.1.1.3 Installing QE for Display [RX,RA] by downloading the installer from the Web site 

Download QE from the following URL for installation. 

• QE for Display V3.1.0: Development Assistance Tool for Display 

https://www.renesas.com/qe-display#downloads 
 
Refer to the following for how to install QE for Display [RX,RA]. 

1. Start the e2 studio. 

2. Select the “Install New Software...” menu item from the “Help” menu to open the “Install” dialog box. 

3. Click on the “Add...” button to open the “Add Repository” dialog box. 

4. Click on the “Archive” button, select the zip file for installation in the dialog box for selecting a file that has 

opened, and click on the “Open” button. 

5. Click on the “OK” button in the “Add Repository” dialog box. 

6. Expand the “Renesas QE” item shown in the “Install” dialog box, select the “Renesas QE for Display 

[RX,RA]” checkbox, and then click on the “Next” button. 

*You can deselect the “Contact all update sites during install to find required software” checkbox to 

shorten the installation time. 

7. Confirm that the target of installation is correctly selected and click on the “Next” button. 

8. After confirming the license agreement, select the “I accept the terms of the license agreements” radio 

button if you agree with the license agreement, and click on the “Finish” button. 

9. If the dialog box for the trust certificate is displayed, confirm the certificate and click on the “Accept 

selected” button to continue installation. 

10. Restart the e2 studio by following the instructions on the screen. 

11. Start this product from the “Renesas QE” menu under “Renesas Views” of the e2 studio. 
 
  

https://www.renesas.com/qe-display#downloads
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4.1.2 Uninstalling QE for Display [RX,RA] 

To uninstall QE for Display [RX,RA], follow the procedure below. 

1. Start the e2 studio. 

2. From the “Help” menu, select the “About e2 studio” menu item, click on the “Installation Details” button to 

open the “e2 studio Installation Details” dialog box. 

3. Select “Renesas QE for Display [RX,RA]” displayed on the “Installed Software” tabbed page and click on 

the “Uninstall...” button to open the “Uninstall” dialog box. 

4. Confirm the displayed information and click on the “Finish” button. 

5. Restart the e2 studio by following the instructions on the screen. 
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4.2 Creating a New Project 

Create a project with the e2 studio. 

1. Click on “File” -> “New”, and then “C/C++ Project”. 
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2. Select “Renesas RX” -> “Renesas CC-RX C/C++ Executable Project” and click on “Next”. 
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3. Enter the name of the project in the “Project name:” text box and click on “Next”. 
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4. Select the board to be used from the “Target Board:” combo box. After selecting the target board, the 

selection from the “Target Device:” combo box is automatically made.  

If the name of the board to be used is not included in the selection list, download the Board Description 

File (BDF). Click on [Download additional boards…] and download the Board Description File for the 

target board. 

5. Confirm that the checkbox for “Create Hardware Debug Configuration” is selected and select the emulator 

to be used from the combo box below it. Click on “Next”. 
 
 

 

 
Table 4.1, Correspondence between Target Board, Target Device, and Emulator shows the Board 
Description File name, target device, and emulator selection corresponding to each target board. 
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Table 4.1   Correspondence between Target Board, Target Device, and Emulator 

Target Board Target Device Emulator 

RSKRX130-512KB R5F51308AxFN E2 Lite (RX) 

TargetBoardRX130 R5F51308AxFP E2 Lite (RX) 

RSKRX140 R5F51406BxFN E2 Lite (RX) 

RSKRX231 R5F52318AxFP E2 Lite (RX) 

TargetBoardRX231 R5F52318AxFP E2 Lite (RX) 

RSSKRX23W R5F523W8AxBL E2 Lite (RX) 

TargetBoardRX23W R5F523W8AxNG E2 Lite (RX) 

TargetBoardRX23Wmodule R5F523W8CxLN E2 Lite (RX) 

RSKRX64M R5F564MLCxFC E2 Lite (RX) 

TargetBoardRX65N R5F565NEDxFP E2 Lite (RX) 

RSKRX660 R5F56609HxFB E2 Lite (RX) 

TargetBoardRX660 R5F56609BxFP E2 Lite (RX) 

RSKRX671 R5F5671EHxFB E2 Lite (RX) 

TargetBoardRX671 R5F5671EHxFP E2 Lite (RX) 

RSKRX71M R5F571MLCxFC E2 Lite (RX) 
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6. Select the “Use Smart Configurator” checkbox. 

7. Click on “Finish”. 
 

 

 

8. When the following message is displayed, click on “Open Perspective”. 
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9. The project is created and the Smart Configurator is opened. 
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4.3 Making the Clock Settings 

 
Make clock settings to suit the board to be used. 

1. Select the “Clocks” tab of the Smart Configurator. 

2. Set the clock according to the board to be used.  

When using a Board Description File, the default settings are adjusted according to the board; no 

changes are required. 

When not using a Board Description File, set to values that meet the target usage environment. 

3. When the clocks have been set, click on the “Generate Code” button     in the upper-right corner of the 

window. 
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4.4 Setting the LCD According to the Workflow of QE for Display [RX,RA] 

Start QE for Display [RX,RA] and set the LCD in the order of “1. Preparation” and “3. GUI Creation on LCD” 
in the workflow view. 

Start QE for Display [RX,RA]. 

1. Select “Renesas Views” -> “Renesas QE” -> “LCD Main RX,RA (QE)”. 
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4.4.1 Preparation 

Make the settings for “1. Preparation” in the workflow view of QE for Display [RX,RA]. 

1. In “Selecting a project”, select the target project. Once the project is selected, the entries for “Evaluation 

board”, “LCD maker/Type”, and “Model name/Size” are automatically displayed. 

If you are using a board other than one of those listed in Table 4.2, Correspondences between 

“Evaluation Board”, “LCD maker/Type”, and “Model name/Size”, select “Custom” in the “LCD maker/Type” 

combo box and add the information on the LCD to be used in the “Edit Custom Display Data” dialog box. 

For details on how to add LCD information, refer to the explanation produced by clicking on the “Help” 

button. 
 
Table 4.2   Correspondences between “Evaluation Board”, “LCD maker/Type”, and “Model name/Size” 

LCD maker/Type Model name/Size 

OKAYA RH128128T-1X44WN-B2 / 128x128 

Kuongshun Electronic MSP2807 / 320x240 

 
 

 

  

Automatically displayed 

according to the selected project. 
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4.4.2 Create a GUI for an LCD 

The following shows the procedure for installing a GUI drawing tool using emWin. 
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1. Select the “Components” tab of the Smart Configurator and click on the “Add component” icon. 

2. In the “New Component” dialog box, select “Graphic Library with Graphical User Interface (r_emwin_rx)” 

(version 6.26.c.1.00 or a later version) and click on the “Finish” button. 
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3. If the graphic library is not displayed in the list of components in the “New Component” dialog box, click 

on “Download the latest FIT drivers and middleware”. 
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4. In the “FIT Module Download” dialog box, remove the check against “Show RX Driver Package only” and 

select “RX Family emWin v6.26 module”. 

5. Click on “Download”. 
 

 

 

6. Read the description in the “End User License Agreement (Sample Code)” dialog box. If you agree, click 

on “Accept”. 
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7. When “Graphic Library with Graphical User Interface (r_emwin_rx)” is displayed in the list of components, 

select it and click on the “Finish” button. 
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8. Components that have a dependency on the added component will be automatically added. However, a 

component that has not been added or a component with a version that differs from the required one will 

lead to an error message or a warning. 

In such cases, add the required component or update the version. 

The following example shows a warning issued regarding the component version of [r_cmt_rx] and 

[r_gpio_rx]. 
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Update the component to the required version (r_cmt_rx). 

9. Right-click on the component for r_cmt_rx and select “Change version”. 
 

  

 

10. Confirm “Available versions” in the “Change Version” dialog box and click on “Next”. 

11. Confirm “Setting Overview” and click on “Finish”. 
 

     

 

12. When the confirmation message is displayed in the “Change Version” dialog box, click on “Yes”. 
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13. When the confirmation message is displayed in the “Code Generation” dialog box, click on “Proceed”. 

Any other errors or warnings should also be dealt with in the same manner. 
 

  

 

14. The error and warnings regarding the dependencies of components have now been resolved. 
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Set the LCD connection method to be used in emWin. 
 

When using an RSK board (RSK RX130,RSK RX140,RSK RX231,RSSK RX23W,RSK RX64M, RSK 

RX660,RSK RX671,or RSK RX71M), the LCD display manufactured by OKAYA & Co., Ltd. is selected by 

the default. If you are using an OKAYA display, configure the emWin settings according to steps 15, 16, and 
17 below. 
 

When using a Target Board (Target Board RX130,Target Board RX231,Target Board RX23W,Target Board 

RX23W module,Target Board RX65N,Target Board RX660,or Target Board RX671), the LCD display 

manufactured by Kuongshun Electronic Ltd. is selected as by default. If you are using the Kuongshun 

Electronic display, configure the emWin settings according to steps 15, 18, and 19 below. 

Steps 20 and beyond apply to both displays. 

 

15. Select “r_emwin_rx” from the components. 

 

16. Set the [LCD interface] value to [LCD_IF_SCI_SPI]. 
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17. When selecting a board in the creation of a project, setting [LCD interface] to [LCD_IF_SCI_SPI] also 

adds the related FITs (r_sci_rx and r_byteq). 

Select [r_sci_rx] from Components and set the following. 

 

(1) Use SSPI mode : Include 

(2) Byte value to transmit while clocking in data in SSPI mode : 0x00 

(3) Include software support for channel6  

(SCI channel number to be used) : 

 

Include 

(4) SCI6 (SCI channel number to be used) :  Check “include” for all pins excluding CTS 

 

  
 

 

  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 37 of 71 

Oct.31.22  

For (3) and (4), select the SCI channel that corresponds to the board specifications. 
 
 

Table 4.3   Channel Numbers to be Used 

Evaluation Board SCI Channel Number 

RSKRX130-512KB 6 

RSKRX140 6 

RSKRX231 8 

RSSKRX23W 12 

RSKRX64M 6 

RSKRX660 6 

RSKRX671 6 

RSKRX71M 6 

 

 

 

For Kuongshun Electronic manufactured display: 
 
The display manufactured by Kuongshun is equipped with an LCD as well as a touch function. 
The channels used for the LCD connection and touch function are as follows. 

 

Table 4.4   Display Interface and Channel Number 

Evaluation Board  LCD Connection Touch Function 

Interface Channel 

Number 

Interface Channel 

Number 

TargetBoardRX130 RSPI 0 SCI_SPI 1 

TargetBoardRX231 RSPI 0 SCI_SPI 0 

TargetBoardRX23W SCI_SPI 1 SCI_SPI 5 

TargetBoardRX23Wmodule SCI_SPI 1 SCI_SPI 12 

TargetBoardRX65N RSPI 0 RSPI 1 

TargetBoardRX660 SCI_SPI 5 SCI_SPI 0 

TargetBoardRX671 SCI_SPI 5 SCI_SPI 0 

 

The RX231 Target Board is used in the following example to describe the setting procedures. For boards 
that use SCI_SPI for LCD connection, use the same settings as described in steps 19 (4) to (7). For boards 
that use RSPI for the touch function, use the same settings as described in steps 19 (1) to (3). 
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18. Set the [LCD interface] value to [LCD_IF_RSPI] and the [Touch interface] value to 

[TOUCH_IF_SCI_SPI]. 

As setting values and channel numbers vary according to each board, refer to Table 4.4, Display 

Interface and Channel Number for details. 
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19. When a board is selected in the creation of a project, setting [LCD_IF_RSPI] and [TOUCH_IF_SCI_SPI] 

also adds the related FITs (r_rspi_rx and r_sci_rx). 

 

RSPI setting: 

Select [r_rspi_rx] from Components and set the following. 

 

(1) Dummy data of reception : 0x00 

(2) RSPI channel 0 (RSPI channel for LCD connection) : Used 

(3) RSPI0 (RSPI channels for LCD connection) : Used 

 

 

 

 

 
  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 40 of 71 

Oct.31.22  

SCI_SPI setting: 
Select [r_sci_rx] from Components and set the following. 
 
 

(4) Use SSPI mode : Include 

(5) Byte value to transmit while clocking in data in SSPI mode : 0x00 

(6) Include software support for channel0 (SCI channel for touch function) : Include 

(7) SCI0 (SCI channels for touch function) : Check “Used” for all pins excluding CTS 
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20. When the pins have been set, click on the “Generate Code” button     in the upper-right corner of the 

window. The code is generated according to the settings. 

 

The [r_bsp] Heap size shows an error, but this can be ignored for serial connections. 

    

 

21. After code generation is finished, “Added” is displayed immediately below “Installing the GUI drawing tool 

driver”. 
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Make the initial settings for the GUI drawing tool. 

22. Clicking on the “Info setting” button displays the “emWin setting” dialog box. 

23. Values are set according to the information on the board selected in the project. 

[LCD interface channel number] must match the channel specified as [Include] by the [r_sci_rx] 

component and the channel specified as [Used] by the [r_rspi_rx] component in the Smart Configurator. 

When using the Kuongshun Electronic LCD display, the values are already set in the [Touch settings] 

section. 

For details, refer to the explanation produced by clicking on the “Help” button. 

Confirm the settings and click on the “OK” button to close the dialog box. 
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24. A header file reflecting the initial settings for the GUI drawing tool is output. 

Click on the “Generate file” button to output qe_emwin_config.h. It is output to src immediately under the 

project folder by default. The output destination folder can be changed by selecting the “Select folder” 

checkbox. 

The path for including the output header files is also automatically added. 
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Install AppWizard, which is to be used to create the GUI. 

25. Click on the “Setting” button under “Generate GUI” to open the “AppWizard settings” dialog box. 

26. Click on the “Installing AppWizard” button to install AppWizard by following the instructions of the 

AppWizard setup wizard that is displayed. 
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27. After having installed AppWizard, the state indicator of the “AppWizard settings” dialog box is changed to 

“AppWizard is installed”. Click on the “OK” button to close the “AppWizard settings” dialog box. 
 

 

 

28. The “Start GUI drawing tool” button is now active. 

Click on this button to start AppWizard. 
 

    

 

Note: The usage of AppWizard may differ from the way which is described in this application note due to 

changes to the specifications. For the usage of AppWizard, refer to its help system. 
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29. When AppWizard is started, the “aw” project folder of AppWizard is automatically created immediately 

under the project. This folder contains Resource, Simulation, and Source folders and the project file for 

AppWizard (aw.AppWizard). 
 

 

 

30. Screen size and other properties are automatically set in the AppWizard project. 

The setting values can be confirmed in the “Edit project properties” dialog box which is opened from the 

“Edit Options” item of the “Project” menu. 
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31. Create a GUI with AppWizard. 

Start by adding a screen. Clicking on the “Screen” button adds “Screen ID_SCREEN_00”. Multiple 

screens can be set and this allows switching between their displays. 
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32. After that, add an image. Clicking on the “Image” button adds “Image ID_IMAGE_00”. The position and 

size are adjusted in “Editor” or “Properties”. In this case, use “Editor” to expand the image to fill the LCD 

screen. 
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33. Set an image. Open “Set bitmap” in “Properties” and click on the rectangle below the label. Select a 

desired image from “Select image for mode <>” and click on “Select”. For the image format to be 

specified, also refer to section 6.2, Usage Note Regarding Image Drawing Speed. 
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34. Clicking on the “Start play mode” button located at the upper right confirms the operation of the created 

GUI in the preview. Clicking on the “Esc” button closes the preview. 

 

 

 

 

 

 

  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 52 of 71 

Oct.31.22  

35. Output code from AppWizard. 

Select the “Export & Save” item from the “File” menu of AppWizard. 

Code is output in the “Source” and “Resource” folders under the “aw” project folder of AppWizard. The 

“Source” and “Resource” folders are automatically specified as the target folders for building. 
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36. Include code for displaying the created GUI in the main() function. 

Click on the “Show sample code” button in the lower part of “3. GUI Creation on LCD” of QE for Display 

[RX,RA]. 

After clicking on the “Copy to the clipboard” button in the “Show sample code” dialog box, click on the 

“OK” button to close it. 
 

    

 

37. Paste the copied code under the user code within the main() function. 
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4.5 Building the Project 

 
Build the project and make the load module according to the following procedure. 

 

1. Click on the project you want to build (e.g. QE_for_Display_RX140_RSK HardwareDebug). 

2. Click on “Build”. 
 

  

 

3. When the “Console” panel displays 'Build complete.', the build operation is complete. 
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4.6 Connecting a Debugger and Executing the Program 

1. Click on the project you want to debug (e.g. QE_for_Display_RX140_RSK HardwareDebug).  

2. Click on “Debug Configurations” from the “Run” menu item. 
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3. Select the “Connection Settings” tab on the “Debugger” tabbed page of the “Debug Configurations” dialog 

box. 

4. Configure the following values according to the target usage environment. 

  [Main Clock Source] 

  [EXTAL Frequency[MHz]] 

  [Connection Type]  

 [Power Target From The Emulator (MAX 200mA)] 

 

 

  



RX Family QE for Display GUI Display Application Development Guide  

using Serial Connection LCD 

R20AN0688EJ0110  Rev.1.10  Page 57 of 71 

Oct.31.22  

5. When the following message is displayed, click on “Switch”. 

  

 

6. When downloading of the load module is completed, the “Debug” perspective opens. 
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7. Click on “Resume” on the tool bar. The program is executed and breaks at the beginning of the main 

function. 
 

 

 

8. After a break occurs at the beginning of the main function, click on “Resume” again on the toolbar. 
 

 

 

9. When the setting of the display device is done correctly, the following screen will be displayed on the LCD 

panel.  
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5. Hardware 

5.1 Configuration of Hardware 

Table 5.1, LCD Panel Used in the Sample shows the LCD panel used in this application note. 

 

Table 5.1   LCD Panel Used in the Sample 

Information on the LCD Panel Product 

Manufacturer: OKAYA Co. 

Part number: RH128128T-1X44WN-B2 

Display size:128 x 128 

Manufacturer: Kuongshun Electronic Co. 

Part number: MSP2807 

Display size:320 x 240 

Built-in touch controller 

 

5.2 Pin Functions 

Set the pin functions according to the product you are using. Pin functions are automatically set using the 
Smart Configurator and QE for Display [RX,RA]. 
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Table 5.2   Pins and Functions to be Used (RSK RX130) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PB2 Output LCD CS pin 

PB1/ SMOSI6 Input/output LCD data output pin 

PB0/ SMISO6 Input/output LCD data input pin 

PB3/ SCK6 Input/output LCD clock pin 

PD0 - - 

P17 Output LCD reset pin 

PC2 Output LCD data / command pin 

PC3 Output LCD backlight pin 

 

Table 5.3   Pins and Functions to be Used (Target Board RX130) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PA4 / SSLA0 Output LCD CS pin  

PA6 / MOSIA Input/output LCD data output pin 

PA7/ MISOA Input/output LCD data input pin 

PA5/ RSPCKA Input/output LCD clock pin 

P15 - - 

P17 Output LCD reset pin 

PC3 Output LCD data / command pin 

PC2 Output LCD backlight pin  

P27 / SCK1 Input/output LCD touch function clock pin 

PJ3 Output LCD touch IC CS pin 

P26 / TXD1 Output LCD touch function data input pin  

P30 / RXD1 Input LCD touch function data output pin  

 

Table 5.4   Pins and Functions to be Used (RSK RX140) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PB2 Output LCD CS pin 

PB1/ SMOSI6 Input/output LCD data output pin 

PB0/ SMISO6 Input/output LCD data input pin 

PB3/ SCK6 Input/output LCD clock pin 

P31 - - 

PE4 Output LCD reset pin 

PC7 Output LCD data / command pin 

PC6 Output LCD backlight pin 
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Table 5.5   Pins and Functions to be Used (RSK RX231) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

P33 Output LCD CS pin 

PC7/ SMOSI8 Input/output LCD data output pin 

PC6/ SMISO8 Input/output LCD data input pin 

PC5/ SCK8 Input/output LCD clock pin 

PE6 - - 

PE7 Output LCD reset pin 

PE3 Output LCD data / command pin 

PE4 Output LCD backlight pin 

 
 
Table 5.6   Pins and Functions to be Used (Target Board RX231) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PA4 / SSLA0 Output LCD CS pin  

PA6 / MOSIA Input/output LCD data output pin 

PA7/ MISOA Input/output LCD data input pin 

PA5/ RSPCKA Input/output LCD clock pin 

P15 - - 

P17 Output LCD reset pin 

PC3 Output LCD data / command pin 

PC2 Output LCD backlight pin  

P22 / SCK0 Input/output LCD touch function clock pin 

P05 Output LCD touch IC CS pin 

P20 / TXD0 Output LCD touch function data input pin  

P21 / RXD0 Input LCD touch function data output pin  

 

 

Table 5.7   Pins and Functions to be Used (RSSK RX23W) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PE3 Output LCD CS pin 

PE1/ SMOSI12 Input/output LCD data output pin 

PE2/ SMISO12 Input/output LCD data input pin 

PE0/ SCK12 Input/output LCD clock pin 

PB1 - - 

PB3 Output LCD reset pin 

P03 Output LCD data / command pin 

PJ3 Output LCD backlight pin 
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Table 5.8   Pins and Functions to be Used (Target Board RX23W) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

P31 Output LCD CS pin  

P26 / SMOSI1 Input/output LCD data output pin 

P30/ SMISO1 Input/output LCD data input pin 

P27/ SCK1 Input/output LCD clock pin 

PB1 - - 

PD3 Output LCD reset pin 

P05 Output LCD data / command pin 

PB7 Output LCD backlight pin  

PC4 / SCK5 Input/output LCD touch function clock pin 

P41 Output LCD touch IC CS pin 

PC3 / TXD5 Output LCD touch function data input pin  

PC2 / RXD5 Input LCD touch function data output pin  

 

Table 5.9   Pins and Functions to be Used (Target Board RX23W module) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

P31 Output LCD CS pin  

P26 / SMOSI1 Input/output LCD data output pin 

P30/ SMISO1 Input/output LCD data input pin 

P27/ SCK1 Input/output LCD clock pin 

PB1 - - 

PD3 Output LCD reset pin 

PC3 Output LCD data / command pin 

PC2 Output LCD backlight pin  

PE0 / SCK12 Input/output LCD touch function clock pin 

P05 Output LCD touch IC CS pin 

PE1 / TXD12 Output LCD touch function data input pin  

PE2 / RXD12 Input LCD touch function data output pin  

 
Table 5.10   Pins and Functions to be Used (RSK RX64M) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

P45 Output LCD CS pin 

P00/ SMOSI6 Input/output LCD data output pin 

P01/ SMISO6 Input/output LCD data input pin 

P02/ SCK6 Input/output LCD clock pin 

P20 - - 

P21 Output LCD reset pin 

P46 Output LCD data / command pin 

P47 Output LCD backlight pin 
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Table 5.11   Pins and Functions to be Used (Target Board RX65N) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PA4 / SSLA0-B Output LCD CS pin  

PA6 / MOSIA-B Input/output LCD data output pin 

PA7/ MISOA-B Input/output LCD data input pin 

PA5/ RSPCKA-B Input/output LCD clock pin 

P15 - - 

P17 Output LCD reset pin 

PC3 Output LCD data / command pin 

PC2 Output LCD backlight pin  

PE5 / RSPCKB-B Input/output LCD touch function clock pin 

P05 Output LCD touch IC CS pin 

PE6 / MOSIB-B Input/output LCD touch function data input pin  

PE7 / MISOB-B Input/output LCD touch function data output pin  

 

Table 5.12   Pins and Functions to be Used (RSK RX660) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PJ3 Output LCD CS pin 

P00/ SMOSI6 Input/output LCD data output pin 

P01/ SMISO6 Input/output LCD data input pin 

P02/ SCK6 Input/output LCD clock pin 

P56 - - 

PL0 Output LCD reset pin 

P71 Output LCD data / command pin 

P72 Output LCD backlight pin 

 
Table 5.13   Pins and Functions to be Used (Target Board RX660) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PC0 Output LCD CS pin  

PC3 / SMOSI5 Input/output LCD data output pin 

PC2 / SMISO5 Input/output LCD data input pin 

PC1 / SCK5 Input/output LCD clock pin 

PB0 - - 

PB1 Output LCD reset pin 

PB7 Output LCD data / command pin 

PB6 Output LCD backlight pin  

P34 / SCK0 Input/output LCD touch function clock pin 

P06 Output LCD touch IC CS pin 

P32 / TXD0 Output LCD touch function data input pin  

P33 / RXD0 Input LCD touch function data output pin  
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Table 5.14   Pins and Functions to be Used (RSK RX671) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PJ3 Output LCD CS pin 

P00/ SMOSI6 Input/output LCD data output pin 

P01/ SMISO6 Input/output LCD data input pin 

P02/ SCK6 Input/output LCD clock pin 

P56 - - 

P74 Output LCD reset pin 

P71 Output LCD data / command pin 

P72 Output LCD backlight pin 

 
Table 5.15   Pins and Functions to be Used (Target Board RX671) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

PC0 Output LCD CS pin  

PC3 / SMOSI5 Input/output LCD data output pin 

PC2 / SMISO5 Input/output LCD data input pin 

PC1 / SCK5 Input/output LCD clock pin 

PB0 - - 

PB1 Output LCD reset pin 

PB7 Output LCD data / command pin 

PB6 Output LCD backlight pin  

P22 / SCK0 Input/output LCD touch function clock pin 

P05 Output LCD touch IC CS pin 

P20 / TXD0 Output LCD touch function data input pin  

P21 / RXD0 Input LCD touch function data output pin  

 

Table 5.16   Pins and Functions to be Used (RSK RX71M) 

Connected 

Device 

Pin Name Input/Output Description 

RH128128T-
1X44WN-B2 

P45 Output LCD CS pin 

P00/ SMOSI6 Input/output LCD data output pin 

P01/ SMISO6 Input/output LCD data input pin 

P02/ SCK6 Input/output LCD clock pin 

P20 - - 

P21 Output LCD reset pin 

P46 Output LCD data / command pin 

P47 Output LCD backlight pin 
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5.3 LCD Connections 

Board and LCD connections are listed below. 
 

・RH128128T-1X44WN-B2 (manufactured by OKAYA)  

The default setting when using an RSK board is the RH128128T-1X44WN-B2 LCD. 
This LCD is equipped with a Pmod connector and should be connected to the board’s Pmod1 pin (Pmod2 for 
RSSK RX23W). 
 
 

・MSP2807 (manufactured by Kuongshun Electronic) 

The default setting when using a Target Board is the MSP2807 LCD. 
Connect the LCD using the pins as indicated below. 

 
Table 5.17   LCD Connection Pins 

MSP2807 Board Pin 

VCC Pmod1-6 

GND Pmod1-11 

CS Pmod1-1 

RESET Pmod1-8 

DC/RS Pmod1-9 

SDI(MOSI) Pmod1-2 

SCK Pmod1-4 

LED Pmod1-10 

SDO(MISO) Pmod1-3 

 
 

Table 5.18   Touch Function Connection Pins (Target Board RX130) 

MSP2807 MCU Pin (Port) 

T_CLK 21 (P27) 

T_CS 4 (PJ3) 

T_DIN 22 (P26) 

T_DO 20 (P30) 

T_IRQ - 

 
 
Table 5.19   Touch Function Connection Pins (Target Board RX231) 

MSP2807 MCU Pin (Port) 

T_CLK 26 (P22) 

T_CS 100 (P05) 

T_DIN 28 (P20) 

T_DO 27 (P21) 

T_IRQ - 
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Table 5.20   Touch Function Connection Pins (Target Board RX23W) 

MSP2807 MCU Pin (Port) 

T_CLK 26 (PC4) 

T_CS 51 (P41) 

T_DIN 27 (PC3) 

T_DO 29 (PC2) 

T_IRQ - 

 
Table 5.21   Touch Function Connection Pins (Target Board RX23W module) 

MSP2807 MCU Pin (Port) 

T_CLK 22 (PE0) 

T_CS 64 (P05) 

T_DIN 21 (PE1) 

T_DO 56 (PE2) 

T_IRQ - 

 
 
Table 5.22   Touch Function Connection Pins (Target Board RX65N) 

MSP2807 MCU Pin (Port) 

T_CLK 73 (PE5) 

T_CS 100 (P05) 

T_DIN 72 (PE6) 

T_DO 71 (PE7) 

T_IRQ - 

 
 
Table 5.23   Touch Function Connection Pin (Target Board RX660) 

MSP2807 MCU Pin (Port) 

T_CLK 16 (P34) 

T_CS 1 (P06) 

T_DIN 18 (P32) 

T_DO 17 (P33) 

T_IRQ - 

 
 
Table 5.24   Touch Function Connection Pins (Target Board RX671) 

MSP2807 MCU Pin (Port) 

T_CLK 26 (P22) 

T_CS 100 (P05) 

T_DIN 28 (P20) 

T_DO 27 (P21) 

T_IRQ - 
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6. Details of Settings 

This chapter gives supplementary explanations and notes for each of the procedures described in section 
1.1, System Development Flow Using QE for Display [RX,RA], System Development Flow Using QE for 
Display [RX,RA]. 

 

6.1 From Execution to the End of Adjustment 

After the program has been created, start the debugger and execute the program. If the initial screen is not 
correctly displayed, the settings are not correct. Check the values adjusted by QE for Display [RX,RA] and 
the settings of parameters of the r_sci_rx FIT module.   
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6.2 Usage Note Regarding Image Drawing Speed 

This chapter describes points for caution on the image drawing speed. 

 

6.2.1 Usage Notes for Using JPEG Images with AppWizard 

Since there is no JPEG decoder in the hardware for the RX family, the drawing speed will be slow when 
JPEG images are used. Therefore, the use of JPEG images is not recommended. However, JPEG images 
can be converted to the bitmap format and used without slowing down the drawing speed. This can also be a 
way of saving memory. 

To convert the JPEG format to the bitmap format, expand “Set bitmap” in “Properties” and select any image 
in a JPEG format. AppWizard will automatically convert the image from JPEG to the bitmap format. 

If the JPEG image is not displayed on the LCD, this can be resolved by adjusting the stack size or heap size. 

 

 

 

 

Figure 6.1   Expanding “Set bitmap” and Selecting a JPEG Image 
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6.3 Usage Note regarding the use of QE for Display[RX,RA] V3.1.0 

This chapter describes points for caution on the use of QE for Display[RX,RA] V3.1.0. 

 

6.3.1 Usage Notes for Using the "Kuongshun Electronic - MSP2807" LCD with Specific 
Evaluation Boards 

When selecting the specific board in the [Target Board:] field during project creation and selecting the 
"Kuongshun Electronic -MSP2807" LCD in the [LCD Main RX,RA (QE)] view, the incorrect display size is set 
in the [emWin setting] dialog. 

Correct: 240 (Width) × 320 (Height) 

Incorrect: 280 (Width) × 320 (Height) 

 

The specific boards are as follows 

1. Renesas Starter Kit / Renesas Solution Starter Kit listed in the “Chapter 2 Operating Environment” 

2. Evaluation Boards not listed in the “Chapter 2 Operating Environment” 

3. No evaluation board 

 

Select “Custom...” in the [Maker / Type:] combo box and create a "Kuongshun Electronic -MSP2807" LCD 
as a custom display. 

Set the following values for LCD information. 

1. Display Size (Width): 240 

2. Display Size (Height): 320 

3. Driver IC: ILI9341 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
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5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 

each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 

system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 

disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 

that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 

not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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